### TABLE OF CONTENTS

CHAPTER 1 .................................................. 1  
**Organized Chaos**  
Managing Photos Using the Organizer

- Importing Your Photos ........................................... 2
- Backing Up Your Photos to a Disc or Hard Drive .................. 6
- Importing Photos from Your Scanner ................................. 8
- Automating the Importing of Photos by Using Watched Folders ................................................. 9
- Changing the Size of Your Photo Thumbnails .................................. 10
- Seeing Full-Screen Previews ..................................... 11
- Sorting Photos by Date and Viewing Filenames .................. 13
- Adding Scanned Photos? Enter the Right Time and Date ........ 14
- Finding Photos Fast by Their Month and Year .................. 15
- Tagging Your Photos (with Keyword Tags) ........................ 16
- Auto Tagging with Smart Tags ..................................... 20
- Tagging Multiple Photos ......................................... 22
- Assigning Multiple Tags to One Photo ............................ 23
- Tagging Images of People ....................................... 24
- Combining (Merging) Keyword Tags ............................... 26
- Sharing Your Keyword Tags with Others .......................... 27
- Albums: It's How You Put Photos in Order One by One .......... 28
- Using Smart Albums for Automatic Organization ............. 29
- Choosing Your Own Icons for Keyword Tags .................. 31
- Deleting Keyword Tags or Albums ................................ 32
- Seeing Your Photo's Metadata (EXIF Info) ........................ 33
- Adding Your Own Info to Photos .................................. 34
- Finding Photos .................................................. 35
- Finding Photos Using the Date View .............................. 38
- Seeing an Instant Slide Show ..................................... 40
- Comparing Photos ................................................ 43
- Comparing Photos by Zooming and Panning ..................... 45
- Reducing Clutter by Stacking Your Photos ...................... 47
- Putting Your Photos on a Map ................................... 49
- Sharing Your Photos ............................................. 54
## TABLE OF CONTENTS

**CHAPTER 2** ................................................. 59  
**Raw Justice**  
Processing Your Images Using Camera Raw  
- Opening RAW, JPEG, and TIFF Photos into Camera Raw .................. 60  
- Miss the JPEG Look? Try Applying a Camera Profile .................. 62  
- The Essential Adjustments: White Balance .......................... 64  
- The Essential Adjustments #2: Exposure .......................... 68  
- Letting Camera Raw Auto Correct Your Photos .................. 74  
- The Fix for Shadow Problems: Fill Light .......................... 75  
- Adding “Snap” (or Softening) to Your Images Using the Clarity Slider .................. 77  
- Making Your Colors More Vibrant .......................... 79  
- Cropping and Straightening .......................... 80  
- Editing Multiple Photos at Once .................. 84  
- Saving RAW Files in Adobe's Digital Negative (DNG) Format .................. 86  
- Sharpening in Camera Raw .......................... 87  
- Camera Raw’s Noise Reduction .......................... 92  
- Removing Red Eye in Camera Raw .......................... 93  
- The Trick for Expanding the Range of Your Photos .................. 95  
- Black & White Conversions in Camera Raw .................. 99  

**CHAPTER 3** ................................................ 103  
**Scream of the Crop**  
How to Resize and Crop Photos  
- Cropping Photos .......................... 104  
- Cropping Using the “Rule of Thirds” .................. 107  
- Auto-Cropping to Standard Sizes .................. 110  
- Cropping to an Exact Custom Size .................. 112  
- Cropping into a Shape .......................... 115  
- Using the Crop Tool to Add More Canvas Area .................. 118  
- Auto-Cropping Gang-Scanned Photos .................. 120  
- Straightening Photos with the Straighten Tool .................. 121  
- Resizing Digital Camera Photos .................. 123  
- Resizing and How to Reach Those Hidden Free Transform Handles .................. 126  
- Making Your Photos Smaller (Downsizing) .................. 127  
- Automated Saving and Resizing .................. 129  
- Resizing Just Parts of Your Image Using the Recompose Tool .................. 131
<table>
<thead>
<tr>
<th>TABLE OF CONTENTS</th>
<th><a href="http://www.kelbytraining.com">www.kelbytraining.com</a></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CHAPTER 4</strong></td>
<td>139</td>
</tr>
<tr>
<td><strong>Jonas Sees in Color</strong></td>
<td></td>
</tr>
<tr>
<td>Color Correction Secrets</td>
<td></td>
</tr>
<tr>
<td>Before You Color Correct Anything, Do This First!</td>
<td>140</td>
</tr>
<tr>
<td>The Advantages of Adjustment Layers</td>
<td>142</td>
</tr>
<tr>
<td>Photo Quick Fix</td>
<td>146</td>
</tr>
<tr>
<td>Getting a Visual Readout (Histogram) of Your Corrections</td>
<td>151</td>
</tr>
<tr>
<td>Color Correcting Digital Camera Images</td>
<td>152</td>
</tr>
<tr>
<td>Dave’s Amazing Trick for Finding a Neutral Gray</td>
<td>160</td>
</tr>
<tr>
<td>Studio Photo Correction Made Simple</td>
<td>162</td>
</tr>
<tr>
<td>Drag-and-Drop Instant Color Correction</td>
<td>164</td>
</tr>
<tr>
<td>Adjusting Flesh Tones</td>
<td>167</td>
</tr>
<tr>
<td>Warming Up (or Cooling Down) a Photo</td>
<td>170</td>
</tr>
<tr>
<td>Color Correcting One Problem Area Fast!</td>
<td>172</td>
</tr>
<tr>
<td>Getting a Better Conversion from Color to Black and White</td>
<td>175</td>
</tr>
<tr>
<td>Correcting Color and Contrast Using Color Curves</td>
<td>180</td>
</tr>
</tbody>
</table>

| **CHAPTER 5**     | 187                    |
| **Little Problems** |                       |
| Fixing Common Problems |                       |
| Using the Smart Brush Tool to Select and Fix at the Same Time | 188 |
| Removing Digital Noise | 193 |
| Focusing Light with Digital Dodging and Burning | 195 |
| Opening Up Shadow Areas That Are Too Dark | 200 |
| Fixing Areas That Are Too Bright | 202 |
| When Your Subject Is Too Dark | 204 |
| Automatic Red-Eye Removal | 207 |
| Instant Red-Eye Removal | 209 |
| Fixing Problems Caused by Your Camera’s Lens | 211 |
| The Elements Secret to Fixing Group Shots | 215 |
| Blending Multiple Exposures (a.k.a. Pseudo-HDR Technique) | 219 |
| CHAPTER 6 | ................................. | .227 |
| Select Start | Selection Techniques | |
| Selecting Square, Rectangular, or Round Areas | .228 |
| Saving Your Selections | .233 |
| Softening Those Harsh Edges | .234 |
| Selecting Areas by Their Color | .236 |
| Making Selections Using a Brush | .238 |
| Selecting Everything on a Layer at Once | .239 |
| Getting Elements to Help You Make Tricky Selections | .240 |
| Easier Selections with the Quick Selection Tool | .241 |
| Removing People (or Objects) from Backgrounds | .243 |

| CHAPTER 7 | ................................. | .247 |
| Retouch Me | Retouching Portraits | |
| Quick Skin Tone Fix | .248 |
| The Power of Layer Masks | .250 |
| Removing Blemishes and Hot Spots | .255 |
| Lessening Freckles or Facial Acne | .257 |
| Removing Dark Circles Under Eyes | .260 |
| Removing or Lessening Wrinkles | .262 |
| Whitening the Eyes | .264 |
| Making Eyes That Sparkle | .266 |
| Whitening and Brightening Teeth | .269 |
| Digital Nose Jobs Made Easy | .272 |
| Transforming a Frown into a Smile | .274 |
| Slimming and Trimming | .276 |
| Advanced Skin Softening | .279 |
| Fixing Reflections in Glasses | .288 |
| CHAPTER 8 | 295 |
| **Clone Wars** | |
| Removing Unwanted Objects | |
| Cloning Away Distractions | 296 |
| Removing Spots and Other Artifacts | 301 |
| Removing Distracting Objects (Healing Brush) | 303 |
| Removing Distracting Stuff Using Content-Aware Fill | 307 |
| Automatically Cleaning Up Your Scenes (a.k.a. The Tourist Remover) | 311 |

| CHAPTER 9 | 317 |
| **Side Effects** | |
| Special Effects for Photographers | |
| Trendy Desaturated Portrait Look | 319 |
| Getting the Grungy, High-Contrast Look Right Within Camera Raw | 329 |
| Converting to Black and White | 332 |
| Panoramas Made Crazy Easy | 334 |
| Creating Drama with a Soft Spotlight | 336 |
| Burned-In Edge Effect (Vignetting) | 339 |
| Using Color for Emphasis | 342 |
| Soft Focus Effect | 344 |
| Replacing the Sky | 356 |
| Neutral Density Gradient Filter | 359 |
| Taming Your Light | 365 |
| Creating Photo Montages | 367 |
| Scott’s Three-Step Portrait Finishing Technique | 371 |
| Fake Duotone | 376 |

| CHAPTER 10 | 381 |
| **Sharpen Your Teeth** | |
| Sharpening Techniques | |
| Basic Sharpening | 382 |
| Creating Extraordinary Sharpening | 389 |
| Luminosity Sharpening | 392 |
| Edge Sharpening Technique | 395 |
| Advanced Sharpening Using Adjust Sharpness | 398 |
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
</table>
| 11      | Fine Print  
Step-by-Step Printing and Color Management | 403   |
|         | Setting Up Your Color Management           | 404   |
|         | Calibrating Your Monitor  
(The Lame Freebie Method)    | 405   |
|         | The Right Way to Calibrate  
Your Monitor (Hardware Calibration)  | 411   |
|         | The Other Secret to Getting Pro-Quality  
Prints That Match Your Screen | 414   |
|         | Making the Print                          | 418   |
|         | My Elements 9 Workflow  
from Start to Finish                          | 423   |

INDEX .................................................................. 428
THE QUICK Q&A YOU’RE GOING TO WISH YOU READ FIRST

Q. So why am I going to wish I read this first?
A. Because there’s a bunch of important stuff found only in here (like where to download the practice files so you can follow along), and if you skip this short Q&A, you’ll keep saying things to yourself like, “I wish they had made these photos available for download” or “I wonder if there’s a website where I can download these photos?” and stuff like that. But there’s more here than that—in fact, this whole section is just to help you get the most out of the book. So, take two minutes and give it a quick read.

Q. Is Matt new to this book?
A. Actually, this is the fourth edition of the book with Matt as my co-author, and I’m thrilled to have him on board (mostly because I gave him all the hard stuff. Okay, that’s not the real reason. Just a perk). Matt’s one of the leading experts on Elements, was a featured columnist for the *Adobe Photoshop Elements Techniques* newsletter, and along with his online Elements classes, articles, and well…he’s “the man” when it comes to Elements 9 (by the way, throughout the book, we just call it “Elements” most of the time—it’s just shorter). So, I asked (read as: begged) him to be my co-author, and the book is far better because of his involvement.

Q. How did you split things up?
A. I (Scott) wrote the chapters on Camera Raw, printing, photographic special effects, sharpening, resizing and cropping, and the special workflow tutorial at the end of the printing chapter. Matt provided the chapters on organizing, color correction, image problems, selections, retouching, and removing unwanted objects, as well as a video on showing your work (including using the Create and Share functions).

Q. Is this book for Windows users, Mac users, or both?
A. Elements 9 is available for both Windows and Macintosh, and the two versions are nearly identical. However, there are three keys on the Mac keyboard that have different names from the same keys on a PC keyboard, but don’t worry, we give you both the Windows and Mac shortcuts every time we mention a shortcut (which we do a lot).

Q. I noticed you said “nearly identical.” What exactly do you mean by “nearly?”
A. Well, here’s the thing: the Editor in Photoshop Elements 9 is the same on both platforms, but this is the first time the Organizer (where we sort and organize our images) is available on the Mac, too. As a result, there are some Organizer functions that aren’t available on the Mac yet, and we’ve noted it in the book wherever this is the case.

Q. What’s the deal with the chapter intros?
A. They’re actually designed to give you a quick mental break, and honestly, they have little to do with the chapters. In fact, they have little to do with anything, but writing these off-the-wall chapter intros is kind of a tradition of mine (so don’t blame Matt—it’s not his fault), but if you’re one of those really “serious” types, you can skip them because they’ll just get on your nerves.
Q. How did you develop the original content for this book?
A. Each year, I’m fortunate enough to train literally thousands of professional digital photographers around the world at my live seminars, and although I’m doing the teaching, at every seminar I always learn something new. Photographers love to share their favorite techniques, and during the breaks between sessions or at lunch, somebody’s always showing me how they “get the job done.” It’s really an amazing way to learn. Plus, and perhaps most importantly, I hear right from their own lips the problems and challenges these photographers are facing in their own work in Elements, so I have a great insight into what photographers really want to learn next. Plus, I’m out there shooting myself, so I’m constantly dealing with my own problems in Elements and developing new ways to make my digital workflow faster, easier, and more fun. That’s because (like you) I want to spend less time sitting behind a computer screen and more time doing what I love best—shooting! So as soon as I come up with a new trick, or if I learn a slick new way of doing something, I just can’t wait to share it with other photographers. It’s a sickness, I know.

Q. So what’s not in this book?
A. We tried not to put things in this book that are already in every other Elements book out there. For example, we don’t have a chapter on the Layers palette or a chapter on the painting tools or a chapter showing how each of Elements’ 110 filters look when applied to the same photograph. We just focused on the most important, most asked-about, and most useful things for digital photographers. In short—it’s the funk and not the junk.

Q. So where are the photos and online chapter we can download?
A. You can download the photos and the video on showing your work from www.kelbytraining.com/books/elements9. Of course, the whole idea is that you’d use these techniques on your own photos, but if you want to practice on ours, we won’t tell anybody. Although Matt and I shot most of the images you’ll be downloading, I asked our friends over at iStockphoto.com and Fotolia.com to lend us some of their work, especially for the portrait retouching chapter (it’s really hard to retouch photos of people you know, and still be on speaking terms with them after the book is published). So, I’m very grateful to iStockphoto.com and Fotolia.com for lending us (you, we, etc.) their images, and I’m particularly thankful they let us (you) download low-res versions of their photos used here in the book, so you can practice on them, as well. Please visit their sites—they’ve got really great communities going on there, and it wouldn’t hurt if you gave them a great big sack of money while you’re there. At the very least, make a stock shot of a big stack of money and upload that. It might turn into an actual big stack of money.

Q. Okay, so where should I start?
A. You can treat this as a “jump-in-anywhere” book because we didn’t write it as a “build-on-what-you-learned-in-Chapter-1” type of book. For example, if you just bought this book, and you want to learn how to whiten someone’s teeth for a portrait you’re retouching, you can just turn to Chapter 7, find that technique, and you’ll be able to follow along and do it immediately. That’s because we spell everything out. So if you’re a more advanced Elements user, don’t let it throw you that we say stuff like “Go under the Image menu, under Adjust Color, and choose Levels” rather than just writing “Open Levels.” We did that so everybody could follow along no matter where they are in the Elements experience. Okay, that’s the scoop. Thanks for taking a few minutes to read this, and now it’s time to turn the page and get to work.
As soon as I saw this album title, I knew I had to use it, because my four-year-old daughter is a big fan of the Jonas Brothers (which on some level should make the Jonas Brothers sad, not only because I doubt that their goal was a fan base that still rides a trike, but because by the time she’s seven, they will already be “old news” to her, and when I bring up their name, she’ll look at me like I’m “forty-a-hundred,” which is how old she thinks I am anyway). Anyway, I knew this was a lock for the title, but then I clicked on the album cover, fully expecting to see Kevin, Joe, and Nick Jonas (familiar faces in our home), but instead it was a totally different band. In fact, the name of the band was also Jonas Sees in Color. You see, I “assumed” that because the word Jonas was in there, that it would be the title of a Jonas Brothers album, but that’s what happens when you assume (what’s that old saying, “When you assume, that makes a sum of a and e”?). Anyway, I wondered on some level if, with that name, the band was trying to do the same thing with their name that some companies do with their product names, so someone not paying close attention might, for example, buy a Buckstar bag of coffee off the grocer’s shelf, when they thought they were buying Starbucks, because of the sound-alike name and the package’s similar look and feel. If that were the case, then someone looking to buy a Jonas Brothers song might actually buy one from Jonas Sees in Color, but in this case, it’s entirely possible they might like the Jonas Sees in Color songs better (hey, don’t bank your career on the attention span of a four-year-old). This got me to thinking, and long story short—that’s precisely why I changed my pen name to J. Kelby Rowling, and my next book is titled *Harry Potter and the Odor of the Pen Tool*. 
Step One:
From the Edit menu, choose **Color Settings** (or press **Ctrl-Shift-K** [Mac: **Command-Shift-K**]).

Step Two:
In the Color Settings dialog, choose from the four options: No Color Management, Always Optimize Colors for Computer Screens, Always Optimize for Printing, or Allow Me to Choose. To a large degree, your choice will depend on your final output; but for photographers, I recommend using Always Optimize for Printing because it reproduces such a wide range (a.k.a. gamut) of colors using the Adobe RGB profile (if your photos don’t already have a profile assigned), and it’s ideal if your photos will wind up in print. Note: For more on color management, see Chapter 11.

Okay, before you start along your merry color correcting way, there are a couple of settings that you should consider changing. These settings can definitely affect the results you get, so make sure you read this first. Also, keep in mind that these changes will remain as your defaults until you change them again, so you don’t have to do this each time you open Elements.
Step Three:
Now we’re moving to a completely different area. Press the letter I to switch to the Eyedropper tool. In the Options Bar, the default Sample Size setting for this tool (Point Sample) is fine for using the Eyedropper to steal a color from within a photo and make it your Foreground color. However, Point Sample doesn’t work well when you’re trying to read values in a particular area (such as flesh tones), because it gives you the reading from just one individual pixel, rather than an average reading of the surrounding area under your cursor.

Step Four:
For example, flesh tones are actually composed of dozens of different colored pixels (just zoom way in and you’ll see what I mean); and if you’re color correcting, you want a reading that’s representative of the area under your Eyedropper, not just a single pixel within that area, which could hurt your correction decision-making. That’s why you need to go to the Options Bar, under the Sample Size pop-up menu, and choose 3 by 3 Average. This changes the Eyedropper to give you a reading that’s the average of 3 pixels across and 3 pixels down in the area that you’re sampling. Once you’ve completed the changes on these two pages, it’s safe to go ahead with the rest of the chapter and start correcting your photos.
The Advantages of Adjustment Layers

Advantage One: 
Undos That Live Forever
By default, Elements keeps track of the last 50 things you’ve done in the Undo History palette (from the Window menu, choose Undo History to open it), so if you need to undo a step, or two, or three, etc., you can press Ctrl-Z (Mac: Command-Z) up to 50 times. But, when you close your document, all those undos go away. However, when you make an edit using an adjustment layer (like a Levels adjustment), you can save your image as a layered file (just save it in Photoshop format), and your adjustment layers are saved right along with it. You can reopen that document days, weeks, or even years later, click on that adjustment layer, and either undo or change that Levels (or whatever other one you used) adjustment. It’s like an undo that lives forever.

Advantage Two: 
Built-In Masks
Each adjustment layer comes with a built-in layer mask, so you can easily decide which parts of your photo get the adjustment just by painting. If you want to keep an area of your photo from having the adjustment, just get the Brush tool (B) and paint over it in black. There’s more on layer masks to come. They offer tremendous flexibility, and since they don’t actually affect the pixels in your image, they’re always undoable.

Before we really dive into color, we need to spend two minutes with the Adjustments palette. Of all the enhancements in Elements 8, the Adjustments palette was at the top of the list, because it streamlined our workflow so dramatically that even if you had never used adjustment layers before, you had to start working with them. In fact, from this point in the book on, we’re going to try to use adjustment layers every chance we get, because of all the advantages they bring. Here’s a quick look at them and why we need them:
Advantage Three: Blend Modes

When you apply an adjustment layer, you get to use the layer blend modes. So if you want a darker version of your adjustment, you can just change the layer blend mode of your adjustment layer to Multiply. Want a brighter version? Change it to Screen. Want to make a Levels adjustment that doesn’t affect the skin tone as much? Change it to Luminosity. Sweet!

Advantage Four: Everything Stays Live

Back in previous versions of Elements, when you created an adjustment layer (let’s say a Levels adjustment layer, for example), it would bring up the floating Levels dialog (as seen here). While it was onscreen, the rest of Elements was frozen—you couldn’t make changes or do anything else until you closed the Levels dialog by either applying your adjustment or clicking Cancel. But thanks to the Adjustments palette, everything stays live—you just go to the Adjustments palette (which will open when you add an adjustment layer) and make your changes there. There is no OK or Apply button, so you can change anything anytime. This will make more sense in the next step.

Continued
Step One:
The best way to understand this whole “live” thing is to try it, so go open any photo (it really doesn’t matter which one), then click on the Create New Adjustment Layer icon at the bottom of the Layers palette (it’s the half-black/half-white circle) and choose Levels from the pop-up menu to open the Adjustments palette. Rather than bringing up the Levels dialog in front of your image (and freezing everything else), the Adjustments palette displays the Levels controls, so you can make your adjustments while everything stays live—you can adjust your Levels sliders, go up to the Layers palette and change the blend mode of a layer, or paint a few brush strokes, then grab another slider and adjust it. There’s no OK button, and again, everything stays live. This is bigger than it sounds (ask anyone who has used an earlier version of Elements).

Step Two:
Let’s delete our Levels adjustment layer by clicking-and-dragging it onto the Trash icon at the bottom of the Layers palette, and then let’s add a Hue/Saturation adjustment layer by clicking on the Create New Adjustment Layer icon at the bottom of the palette again, but this time choose Hue/Saturation from the pop-up menu. When the Hue/Saturation controls appear in the Adjustments palette, drag the Saturation slider all the way over to the left to remove the color, for the look you see here.
Step Three:
Now, the way adjustment layers work is this: they affect every layer below them. So, if you have five layers below your active layer, all five layers will have their color desaturated like this. However, if you want this adjustment layer to just affect the one single layer directly below the active layer (and not the others), then click on the clipping icon (it’s the first icon on the left at the bottom of the Adjustments palette, shown circled here in red). This clips the adjustment layer to the layer directly beneath it and now the adjustment layer will only affect that layer.

Step Four:
There are a some other options when working with adjustment layers: To edit any adjustment layer you’ve already created, just click on it once in the Layers palette and its controls will appear in the Adjustments palette. To hide any adjustment layer you’ve created, click on the Eye icon (either at the bottom of the Adjustments palette, or to the left of the adjustment layer itself in the Layers palette). To reset any adjustment layer controls to their default settings, click the round arrow icon (the fourth from the left) at the bottom of the Adjustments palette. To see a before/after of just your last adjustment layer change, click the icon to the left of the Reset icon.
Photo Quick Fix

Step One:
Open the photo that needs color correcting (in the example we’ll use here, our photo [shown below] needs the works—color correction, more contrast, and some sharpening). So, click on Quick at the top of the Edit tab to go to Quick Fix mode.

Step Two:
The Quick Fix window shows you side-by-side, before-and-after versions of the photo you’re about to correct (before on the top or left, after on the bottom or right). If you don’t see this view, go to the View pop-up menu in the bottom left of the window and select Before & After (Horizontal or Vertical). To the right of your side-by-side preview is a group of nested palettes offering tonal and lighting fixes you can perform on your photo. Start with the Smart Fix palette at the top. Click the Auto button and Smart Fix will automatically analyze the photo and try to balance the overall tone (adjusting the shadows and highlights), fixing any obvious color casts while it’s at it. In most cases, this feature does a surprisingly good job. There’s also a Fix slider within Smart Fix that you can use to increase (or decrease) the effect of the Smart Fix.

Elements’ Quick Fix does exactly what it says. It quickly fixes your photos and it’s a great tool if you don’t have a lot of experience with color correction or fixing lighting and tonal issues. Basically, if you know that something is wrong but you’re not sure where to go, then give Quick Fix a try first. As you become more comfortable in Elements, you’ll outgrow Quick Fix and want to use Levels and Unsharp Mask and all that cool stuff, but if you’re new to Elements, Quick Fix can be a fantastic place to start.
TIP: Auto Smart Fix
By the way, you can also access the Auto Smart Fix command without entering Quick Fix mode by going under the Enhance menu and choosing **Auto Smart Fix** (or just press the keyboard shortcut Ctrl-Alt-M [Mac: Command-Option-M]). However, there are two advantages to applying the Smart Fix here in Quick Fix mode: (1) you get the Fix slider, which you don’t get by just applying it from the menu or the shortcut; and (2) you get a side-by-side, before-and-after preview so you can see the results as you’re making your edits. So if it turns out that you need additional fixes (or Smart Fix didn’t work as well as you’d hoped), you’re already in the right place.

Step Three:
If you apply Smart Fix and you’re not happy with the results, don’t try to stack more “fixes” on top of that—instead, click the Reset button that appears at the bottom of the Palette Bin to reset the photo to how it looked when you first entered Quick Fix mode. If the color in your photo looks a little flat and needs more contrast, try the Levels Auto button, found in the Lighting palette (the second palette down). I generally stay away from Auto Contrast, as Auto Levels seems to do a better job. There’s another very powerful tool in this palette—the Shadows slider. Drag it to the right a little bit, and watch how it opens up the dark shadow areas in your photo (mainly in the darker buildings in the lower right here). When you’re done with the slider, click the Commit checkmark in the palette header.

*Continued*
Step Four:
You may notice a right-facing arrow to the right of each slider in Quick Fix. Just click on an arrow and a group of thumbnails will appear below the slider. As you hover your cursor over each thumbnail, you’ll see a preview of your image with that setting, so you don’t have to drag the slider back and forth. If you like one, but want just a little more (or less) of the setting, click-and-drag from side to side on a thumbnail to move the slider in increments of 1. This lets you adjust each setting in a more visual (and sometimes precise) way. Now, on to more Quick Fixing.

Step Five:
The next palette down, Color, has an Auto button that (surprisingly enough) tries to remove color casts and improve contrast like Smart Fix and Levels do, but it goes a step further by including a midtones correction that can help reduce color casts in the midtone areas. Hit the Reset button to remove any corrections you’ve made up to this point, and then try the Auto button in the Color palette. See if the grays in the photo don’t look grayer and less red. In fact, with this photo, everything looks cooler and less red. Here’s the thing, though: just because it looks cooler doesn’t mean that it’s right. Elements is just trying to neutralize the photo. In this case, I personally like the warmer feel, but it’s a creative choice by you at this point. The Saturation and Hue sliders here are mostly for creating special color effects (try them and you’ll see what I mean). You can pretty much ignore these sliders unless you want to get “freaky” with your photos. In the Balance palette, the Temperature and Tint sliders will let you manually remove color casts, but honestly, the Auto button in the Color palette is probably going to be your best bet.
Step Six:
After you’ve color corrected your photo (using the Auto buttons and the occasional slider), the final step is to sharpen your photo (by the way, to maintain the best quality, this should be the final step—the last thing you do in your correction process). Just click the Auto button in the Sharpness palette and watch the results. If the photo isn’t sharp enough for you, drag the Sharpen slider to the right to increase the amount of sharpening, but be careful—oversharpening can ruin the photo by becoming too obvious, and it can introduce color shifts and “halos” around objects.

Step Seven:
There are a few other things you can do while you’re here (think of this as a one-stop shop for quickly fixing images). Below the Preview area are icons you can click to rotate your photo (this photo doesn’t need to be rotated, but hey, ya never know). In the Toolbox on the left, there’s a Red Eye Removal tool, if your photo needs it. Just click-and-drag over the problem area in your After preview for red-eye control. The Toolbox also has tools for whitening teeth, making skies blue, and making your photo black and white, but you’ll probably find you like other techniques shown in this book for those tasks better. You know what the Zoom and Hand tools do (they zoom you in, and then move you around), and you can also crop your photo by using the Crop tool within the After preview, so go ahead and crop your photo down a bit. Lastly, you can make a selection with the Quick Selection tool.
Step Eight:
Okay, you’ve color corrected, fixed the contrast, sharpened your image, and even cropped it down to size. So how do you leave Quick Fix mode and return to the regular Elements Editor? Just click on Full at the top of the Edit tab (the same area you went to, to get into Quick Fix mode). It basically applies all the changes to your photo and returns you to the normal editing mode.
A histogram is a graph that shows you the tonal range of your photos (lights, darks, and grays). It’s usually seen in the Levels dialog, but here’s the thing: as you make Levels adjustments, the histogram there isn’t updated live. That’s why there’s a palette dedicated to showing the histogram. That means you can have it open while you’re making adjustments to your photos and get a live reading of how your histogram is looking while you edit.

**Getting a Visual Readout (Histogram) of Your Corrections**

**Step One:**
Open the photo that needs a tonal adjustment. Now, go under the Window menu and choose **Histogram** to open the Histogram palette. (By the way, this palette is only available in Elements’ Full Edit mode—not in Quick Fix mode.)

**Step Two:**
Go under the Enhance menu and choose **Auto Color Correction**. Take a look in the Histogram palette and you’ll see how the Auto Color Correction command affected the photo’s histogram. **Note:** If you see a small symbol in the upper right-hand corner of the graph that looks like a tiny yellow yield sign with an exclamation point in it (as seen in Step One), that’s a warning that the histogram you’re seeing is not a new histogram—it’s a previous histogram cached from memory. To see a fresh histogram, click directly on that warning symbol and a new reading will be generated based on your current adjustment.
Color Correcting
Digital Camera Images

Step One:
Open the digital camera photo you want to color correct. (The photo shown here doesn’t look too bad, but as we go through the correction process, you’ll see that, like most photos, it really needed a correction.)

Step Two:
Go under the Enhance menu, under Adjust Lighting, and choose Levels (or press Ctrl-L [Mac: Command-L]). The dialog may look intimidating at first, but the technique you’re going to learn here requires no previous knowledge of Levels, and it’s so easy, you’ll be correcting photos using Levels immediately.

Ever wonder why the term “color correction” gets thrown around so much? That’s because every digital camera (and even most scanners used for capturing traditional photos) puts its little signature (i.e., color cast) on your photos. Most times it’s a red cast, but it can also be blue or green. Don’t get me wrong—they are getting better, but the color cast is still there. Here’s how to help combat those color problems in Elements:
Step Three:
First, we need to set some preferences in the Levels dialog so we’ll get the results we’re after when we start correcting. We’ll start by setting a target color for our shadow areas. To set this preference, in the Levels dialog, double-click on the black Eyedropper tool (it’s on the right-hand side of the dialog, the first Eyedropper from the left). A Color Picker will appear asking you to “Select target shadow color.” This is where we’ll enter values that, when applied, will help remove any color casts your camera introduced in the shadow areas of your photo.

Step Four:
We’re going to enter values in the R, G, and B (red, green, and blue) fields of this dialog.

- For R, enter 10
- For G, enter 10
- For B, enter 10

TIP: Tab to Change Fields
To move from field to field, just press the Tab key.

Then click OK. Because these figures are evenly balanced (neutral), they help ensure that your shadow areas won’t have too much of one color (which is exactly what causes a color cast—too much of one color).
Step Five:
Now we’ll set a preference to make our highlight areas neutral. Double-click on the highlight Eyedropper (the third of the three Eyedroppers in the Levels dialog). The Color Picker will appear asking you to “Select target highlight color.” Click in the R field, and then enter these values:

- For R, enter 240
- For G, enter 240
- For B, enter 240

Then click OK to set those values as your highlight target.

Step Six:
Finally, set your midtone preference. You know the drill—double-click on the midtones Eyedropper (the middle of the three Eyedroppers) so you can “Select target midtone color.” Enter these values in the R, G, and B fields (if they’re not already there by default):

- For R, enter 128
- For G, enter 128
- For B, enter 128

Then click OK to set those values as your midtone target.
Step Seven:
Okay, you've entered your preferences (target colors), so go ahead and click OK in the Levels dialog (without making any changes to your image). You'll get an alert dialog asking you if you want to “Save the new target colors as defaults?” Click Yes, and from that point on, you won't have to enter these values each time you correct a photo, because they'll already be entered for you—they're now the default settings.

Step Eight:
You're going to use these Eyedropper tools that reside in the Levels dialog to do most of your correction work. Your job is to determine where the shadow, midtone, and highlight areas are, and click the right Eyedropper in the right place (you'll learn how to do that in just a moment). So remember your job—find the shadow, midtone, and highlight areas and click the right Eyedropper in the right spot. Sounds easy, right? It is. You start by opening Levels and setting the shadows first, so you'll need to find an area in your photo that's supposed to be black. If you can't find something that's supposed to be the color black, then it gets a bit trickier—in the absence of something black, you have to determine which area in the image is the darkest. If you're not sure where the darkest part of the photo is, you can use the following trick to have Elements tell you exactly where it is.

Step Nine:
Go to the bottom of the Layers palette and click on the half-black/half-white circle icon to bring up the Create New Adjustment Layer pop-up menu. When the pop-up menu appears, choose Threshold, which brings up the Adjustments palette with a histogram and a slider under it.
Step 10:
In the Adjustments palette, drag the Threshold Level slider under the histogram all the way to the left. Your photo will turn completely white. Slowly drag the slider back to the right, and as you do, you’ll start to see some of your photo reappear. The first area that appears is the darkest part of your image. That’s it—that’s Elements telling you exactly where the darkest part of the image is. Now that you know where your shadow area is, make a mental note of its location. Next, find a white area in your image.

Step 11:
If you can’t find an area in your image that you know is supposed to be white, you can use the same technique to find the highlight areas. With the Adjustments palette still open, drag the slider all the way to the right. Your photo will turn black. Slowly drag the slider back toward the left, and as you do, you’ll start to see some of your photo reappear. The first area that appears is the lightest part of your image. Make a mental note of this area, as well (yes, you have to remember two things, but you have to admit, it’s easier than remembering two PINs). You’re now done with Threshold, so in the Layers palette, just click-and-drag the Threshold adjustment layer onto the Trash icon at the bottom of the palette, because you don’t actually need it anymore.
Step 12:
Press Ctrl-L (Mac: Command-L) to bring up the Levels dialog again. First, select the shadow Eyedropper (the one half-filled with black) from the right side of the Levels dialog. Move your cursor outside the Levels dialog into your photo and click once in the area that Elements showed you was the darkest part of the photo (in Step 10). When you click there, you’ll see the shadow areas correct. (Basically, you just reassigned the shadow areas to your new neutral shadow color—the one you entered earlier as a preference in Step Four.) If you click in that spot and your photo now looks horrible, you either clicked in the wrong spot or what you thought was the shadow point actually wasn’t. Undo the setting of your shadow point by clicking the Reset button in the dialog and try again. If that doesn’t work, don’t sweat it; just keep clicking in areas that look like the darkest part of your photo until it looks right.

Step 13:
While still in the Levels dialog, click on the highlight Eyedropper (the one half-filled with white). Move your cursor over your photo and click once on the lightest part (the one you committed to memory in Step 11) to assign that as your highlight. You’ll see the highlight colors correct.
Step 14:
Now that the shadows and highlights are set, you’ll need to set the midtones in the photo. It may not look as if you need to set them, because the photo may look properly corrected, but chances are there’s a cast in the midtone areas. You may not recognize the cast until you’ve corrected it and it’s gone, so it’s worth giving it a shot to see the effect (which will often be surprisingly dramatic). Unfortunately, there’s no Threshold adjustment layer trick that works well for finding the midtone areas, so you have to use some good old-fashioned guesswork (or try “Dave’s Amazing Trick for Finding a Neutral Gray” next in this chapter). Ideally, there’s something in the photo that’s gray, but not every photo has a “gray” area, so look for a neutral area (one that’s obviously not a shadow, but not a highlight either). Click the middle (gray) Eyedropper in that area. If it’s not right, click the Reset button and repeat Steps 12 through 14.

Step 15:
There’s one more important adjustment to make before you click OK in the Levels dialog and apply your correction. Under the histogram (that’s the black mountain-range-looking thing), click on the center slider (the Midtone Input Levels slider—that’s why it’s gray) and drag it to the left a bit to brighten the midtones of the image. This is a visual adjustment, so it’s up to you to determine how much to adjust, but it should be subtle—just enough to bring out the midtone detail. When it looks right to you, click OK to apply your correction to the highlights, midtones, and shadows, removing any color casts and brightening the overall contrast.
Before

After
Dave’s Amazing Trick for Finding a Neutral Gray

Step One:
Open any color photo and click on the Create a New Layer icon at the bottom of the Layers palette to create a new blank layer. Then, go under the Edit menu and choose Fill Layer. When the Fill Layer dialog appears, in the Contents section, under the Use pop-up menu, choose 50% Gray, and then click OK to fill your new layer with (you guessed it) 50% gray.

Step Two:
Now, go to the Layers palette and change the blend mode pop-up menu to Difference. Changing this layer’s blend mode to Difference doesn’t do much for the look of your photo (in fact, it rarely does), but just remember—it’s only temporary.
Step Three:
Choose **Threshold** from the Create New Adjustment Layer pop-up menu at the bottom of the Layers palette. When the Adjustments palette appears, drag the slider all the way to the left (your photo will turn completely white). Now, slowly drag the slider back to the right, and the first areas that appear in black are the neutral midtones. Make a mental note of where those gray areas are, and then click-and-drag the Threshold adjustment layer onto the Trash icon at the bottom of the palette, because you no longer need it. (In the example shown here, there are neutral midtones in the corner of the building.)

Step Four:
Now that you know where your midtone point is, go back to the Layers palette and drag the 50% gray layer onto the Trash icon (it’s also done its job, so you can get rid of it, too). You’ll see your full-color photo again. Now, press **Ctrl-L** (Mac: **Command-L**) to open Levels, get the midtones Eyedropper (it’s the middle Eyedropper), and click directly on one of the neutral areas. That’s it; you’ve found the neutral midtones and corrected any color within them. So, will this work every time? Almost. It works most of the time, but you will run across photos that just don’t have a neutral midtone, so you’ll have to either not correct the midtones or go back to what we used to do—guess.
If you’re shooting in a studio—whether it’s portraits or products—there’s a technique you can use that makes the color correction process so easy that you’ll be able to train laboratory test rats to correct photos for you. In the back of this book, we’ve included a color swatch card (it’s perforated so you can easily tear it out). After you get your studio lighting set the way you want it, and you’re ready to start shooting, put this swatch card into your shot (just once) and take the shot. What does this do for you? You’ll see.

**Step One:**
When you’re ready to start shooting and the lighting is set the way you want it, tear out the swatch card from the back of this book and place it within your shot (if you’re shooting a portrait, have the subject hold the card for you), and then take the shot. After you’ve got one shot with the swatch card, you can remove it and continue with the rest of your shoot.

**Step Two:**
When you open the first photo taken in your studio session, you’ll see the swatch card in the photo. By having a card that’s pure white, neutral gray, and pure black in your photo, you no longer have to try to determine which area of your photo is supposed to be black (to set the shadows), which area is supposed to be gray (to set the midtones), or which area is supposed to be white (to set the highlights). They’re right there in the card. Note: We’ve even included a Camera Raw White Balance swatch if you’re working with RAW files. See “The Essential Adjustments: White Balance” in Chapter 2 for more info.
Step Three:
Press Ctrl-L (Mac: Command-L) to bring up the Levels dialog. Click the black Eyedropper on the black panel of the card (to set shadows), the middle Eyedropper on the gray panel (for midtones), and the white Eyedropper on the white panel (to set the highlights), and the photo will nearly correct itself. No guessing, no using Threshold adjustment layers to determine the darkest areas of the image—now you know exactly which part of that image should be black and which should be white.

Step Four:
If you’d like to still use this photo, then press C to get the Crop tool and crop the card out of the image. However, the more likely situation is that you don’t want to use this photo (since it does have a big card in it), but you’d now like to apply this color correction to some other photos. Well, now that you have the Levels settings for the first image, you can correct the rest of the photos using the same settings. Just open the next photo and press Ctrl-Alt-L (Mac: Command-Option-L) to apply the exact same settings to this photo that you did to the swatch card photo. Or, you can use the “Drag-and-Drop Instant Color Correction” method that appears next in this chapter.

TIP: Try a Color Checker Chart
If you want to take this process a step further, many professionals use a Munsell ColorChecker color-swatch chart (from X-Rite; www.xrite.com), which also contains a host of other target colors. It’s used exactly the same way: just put the chart into your photo, take one shot, and then when you correct the photo, each color swatch will be in the photo, just begging to be clicked on.
Drag-and-Drop Instant Color Correction

Step One:
First, here's a tip-within-a-tip: If you're opening a group of photos, you don't have to open them one by one. Just go under the File menu and choose Open. In the Open dialog, click on the first photo you want to open, then press-and-hold the Ctrl (Mac: Command) key and click on any other photos you want to open. Then, when you click the Open button, Elements will open all the selected photos. (If all your photos are contiguous, press-and-hold the Shift key and click on the first and last photos in the list to select them all.) So now that you know that tip, go ahead and open at least three or four images, just to get you started.

Step Two:
At the bottom of the Layers palette, click on the Create New Adjustment Layer pop-up menu and choose Levels. Note: An adjustment layer is a special layer that contains the tonal adjustment of your choice (such as Levels, Brightness/Contrast, etc.). There are a number of advantages to having this correction applied as a layer, as you'll soon see, but the main advantage is that you can edit or delete this tonal adjustment at any time while you're working, plus you can save this adjustment with your file as a layer.

Here's a trick for quickly correcting lots of photos that have the same lighting problem. It's a huge time saver! You'll see that it's ideal for photos where your lighting conditions were the same (indoor studio shots are perfect candidates for this one), but it works in plenty of other situations, as well.
Step Three:
When you choose this adjustment layer, you’ll notice that the Adjustments palette appears with your Levels controls. Go ahead and make your corrections using Levels (see “Color Correcting Digital Camera Images” earlier in this chapter). In the Layers palette, you’ll see that a new Levels adjustment layer is created.

Step Four:
Because you applied this correction as an adjustment layer, you can treat this adjustment just like a regular layer, right? Right! And Elements lets you drag layers between open documents, right? Right again! (Note: You must have them open as floating, not tabbed, documents to drag a layer between them.) So, go to the Layers palette, click on the Levels adjustment layer, and drag-and-drop it right onto one of your other open photos. That photo will instantly have the same correction applied to it. This technique works because you’re correcting photos that share similar lighting conditions. Need to correct 12 open photos? Just drag-and-drop it 12 times (making it the fastest correction in town!).

Continued
Step Five:
Okay, what if one of the “dragged corrections” doesn’t look right? That’s the beauty of these adjustment layers. Just click directly on the adjustment layer thumbnail for that photo, and go to the Adjustments palette, where the last settings you applied are still in place. You can then adjust this individual photo separately from the rest. Try this dragging-and-dropping-adjustment-layers trick once, and you’ll use it again and again to save time when correcting a digital roll that has similar lighting conditions.
The Photoshop Elements 9 Book for Digital Photographers

Chapter 4

Continued

Color Correction Secrets

So what do you do if you've used Levels to properly set the highlights, midtones, and shadows, but the flesh tones in your photo still look too red?

You can try this quick trick for getting your flesh tones in line by removing the excess red. This one small adjustment can make a world of difference.

**Adjusting Flesh Tones**

**Step One:**
Open a photo that needs red removed from the flesh tones. If the whole image appears too red, skip this step and move on to Step Three. However, if just the flesh-tone areas appear too red, get the Quick Selection tool (A) and click on all the flesh-tone areas in your photo. (Press-and-hold the Alt [Mac: Option] key to remove any areas that were selected that shouldn't have been, such as the clothes and hair.)

**Step Two:**
Go under the Select menu and choose Feather. Enter a Feather Radius of about 3 pixels, then click OK. By adding this feather, you're softening the edges of your selection, preventing a hard, visible edge from appearing around your adjustments.

Continued
Step Three:
Click on the Create New Adjustment Layer icon at the bottom of the Layers palette, and choose Hue/Saturation from the pop-up menu. Then, in the Adjustments palette, click on the pop-up menu near the top and choose Reds, so you’re only adjusting the reds in your photo (or in your selected areas if you put a selection around the flesh tones).

Step Four:
The rest is easy—you’re simply going to reduce the amount of saturation so the flesh tones appear more natural. Drag the Saturation slider to the left to reduce the amount of red (I moved mine to –20, but you may have to go further to the left, or not as far, depending on how red your skin color is). The changes are live, so you’ll be able to see the effect of reducing the red as you lower the Saturation slider. Also, if you made a selection of the flesh-tone areas, once you create the adjustment layer, it will hide the selection border from view and create a layer mask with your selection. When the flesh tones look right, you’re done.
Before

After
Warming Up (or Cooling Down) a Photo

Before digital photography, you had to adjust your camera for each particular lighting situation (the photo might come out too blue or too warm because of the lighting), and there were filters that you’d screw on to the end of a lens to help combat the effect. Well, Elements has a Photo Filter adjustment, and it works so well at warming and cooling digitally that I don’t even carry those filters in my bag anymore. Here’s how to use it:

Step One:
Open the photo that needs cooling down (or warming up). In the example shown here, the photo is too warm and has a yellowish tint, so we want to cool it down and make it look more natural. Go to the Layers palette and choose Photo Filter from the Create New Adjustment Layer pop-up menu at the bottom of the palette (its icon looks like a half-black/half-white circle).
Step Two:
When the Photo Filter controls appear in the Adjustments palette, choose **Cooling Filter (82)** (or choose a Warming Filter if your image is too cool) from the Filter pop-up menu (this approximates the effect of a traditional screw-on lens filter). If the effect is too cool for you, drag the Density slider to the left to warm the photo up a little. I actually took mine up a bit to 32%.

Step Three:
Because this Photo Filter is an adjustment layer, you can edit where the cooling is applied, so press **B** to switch to the Brush tool. In the Options Bar, click on the down-facing arrow next to the brush thumbnail and choose a soft-edged brush in the Brush Picker. Then, press **X** to make black your Foreground color, and begin painting over any areas that you don’t want to be cool (for example, if you wanted the trees in the foreground to keep their early morning warm color, you’d paint over that area). The original color of the image will be revealed wherever you paint.
Color Correcting One Problem Area Fast!

Step One:
Open the image that has an area of color you would like to enhance, such as the sky.

Step Two:
Go to the bottom of the Layers palette and choose Hue/Saturation from the Create New Adjustment Layer pop-up menu (it’s the half-black/half-white circle icon). A new layer named “Hue/Saturation 1” will be added to your Layers palette and the Hue/Saturation controls will appear in the Adjustments palette. (Note: If you prefer using the Smart Brush tool [covered in Chapter 5], you’ll find it has a Blue Skies option that also works pretty well in cases like this.)

This technique really comes in handy when shooting outdoor scenes because it lets you enhance the color in one particular area of the photo, while leaving the rest of the photo untouched. Real estate photographers often use this trick because they want to present a house on a bright, sunny day, but the weather doesn’t always cooperate. With this technique, a blown-out sky shot at daybreak can become a beautiful blue sky in just seconds.
Step Three:
From the pop-up menu at the top of the Adjustments palette, choose the color that you want to enhance (Blues, Reds, etc.), then drag the Saturation slider to the right. You might also choose Cyans, Magentas, etc., from the pop-up menu and do the same thing—drag the Saturation slider to the right, adding even more color, until your image’s area looks as enhanced as you’d like it. In the example here, I increased the saturation of the Cyans to 30 and the Blues to 65.

Step Four:
Your area is now colorized, but so is everything else. That’s okay; you can fix that easily enough. Press the letter X until your Foreground color is set to black, then press Alt-Backspace (Mac: Option-Delete) to fill the Hue/Saturation layer mask with black. Doing this removes all the color that you just added, but now you can selectively add (actually paint) the color back in where you want it.

Step Five:
Press the letter B to switch to the Brush tool. In the Options Bar, click the down-facing arrow to the right of the brush thumbnail, and in the Brush Picker, choose a large, soft-edged brush. Press X again to toggle your Foreground color to white, and begin painting over the areas where you want the color enhanced. As you paint, the version of your enhanced photo will appear. For well-defined areas, you may have to go to the Brush Picker again in the Options Bar to switch to a smaller, hard-edged brush.
TIP: Fixing Mistakes
If you make a mistake and paint over an area you shouldn’t have (like the land on the right side here)—no problem—just press X again to toggle your Foreground color to black and paint over the mistake—it will disappear. Then, switch back to white and continue painting. When you’re done, the colorized areas in your photo will look brighter.
I’ve run into a lot of digital photographers that use the Remove Color function in Elements to convert from color to black and white. Nearly every single one of them is disappointed with the results. That’s because Elements simply removes the color from the photo and leaves a very bland looking black-and-white image. Plus, there are no settings, so you can’t customize your black-and-white photo in any way. Here’s a great technique that creates a better black and white and gives you plenty of control to really customize the way it looks.

**Getting a Better Conversion from Color to Black and White**

**Step One:**
Open the color photo you want to convert to black and white. Press D to set your Foreground and Background to the default black and white.

**Step Two:**
To really appreciate this technique, it wouldn’t hurt if you went ahead and did a regular conversion to black and white, just so you can see how lame it is. Go under the Image menu, under Mode, and choose Grayscale. When the “Discard color information?” dialog appears, click OK, and behold the somewhat lame conversion. Now that we agree it looks pretty bland, press Ctrl-Z (Mac: Command-Z) to undo the conversion, so you can try something better.
Step Three:  
Go to the bottom of the Layers palette and choose **Levels** from the Create New Adjustment Layer pop-up menu (it’s the half-black/half-white circle icon). The Levels controls will appear in the Adjustments palette and a new layer will be added to your Layers palette named “Levels 1.”

Step Four:  
Press **X** until your Foreground color is set to black, then go to the bottom of the Layers palette and choose **Gradient Map** from the Create New Adjustment Layer pop-up menu. This brings up the Gradient Map options in the Adjustments palette.

Step Five:  
Just choosing Gradient Map gives you a black-and-white image (and doing just this, this one little step alone, usually gives you a better black-and-white conversion than just choosing Grayscale from the Mode submenu. Freaky, I know). If you don’t get a black-to-white gradient, it is because your Foreground and Background colors were not set at their defaults. Click-and-drag the Gradient Map adjustment layer onto the Trash icon at the bottom of the palette, press **D**, then add your Gradient Map adjustment layer again. This adds another layer to the Layers palette (above your Levels 1 layer) named “Gradient Map 1.”
Step Six:
In the Layers palette, click directly on the Levels thumbnail in the Levels 1 layer to bring up the Levels controls in the Adjustments palette again. In the pop-up menu at the top of the palette, you can choose to edit individual color channels (kind of like you would with Photoshop's Channel Mixer). Choose the Red color channel.

Step Seven:
You can now adjust the Red channel, and you'll see the adjustments live onscreen as you tweak your black-and-white photo. (It appears as a black-and-white photo because of the Gradient Map adjustment layer above the Levels 1 layer. Pretty sneaky, eh?) You can drag the middle midtone Input Levels slider to the left to open the shadowy areas in their faces (we use the Red channel, since most of their skin tone is red), as shown here.
Step Eight:
Now, switch to the Green channel in the pop-up menu at the top of the Adjustments palette. You can make adjustments here, as well. Try increasing the highlights in the Green channel by dragging the highlight Input Levels slider to the left, as shown here.

Step Nine:
Now, choose the Blue channel from the pop-up menu, and try increasing the highlights quite a bit and the shadows just a little by dragging the Input Levels sliders (the ones below the histogram that we’ve been using). These adjustments are not standards or suggested settings for every photo; I just experimented by dragging the sliders, and when the photo looked better, I stopped dragging. When the black-and-white photo looks good to you (good contrast and good shadow and highlight details), just stop dragging.
Step 10:
To complete your conversion, go to the Layers palette, click on the flyout menu at the top right, then choose Flatten Image to flatten the adjustment layers into the Background layer. Although your photo looks like a black-and-white photo, technically, it’s still in RGB mode, so if you want a grayscale file, go under the Image menu, under Mode, and choose Grayscale.

Before (lame grayscale conversion)  After (awesome adjustment layers conversion)
Correcting Color and Contrast Using Color Curves

Step One:
Open the photo you want to adjust with Color Curves (a typical situation might be a photo that lacks contrast or has an obvious color cast, but in reality most photos can benefit from a short trip to Color Curves, so don’t just save it for really messed up photos). Then go under the Enhance menu, under Adjust Color, and choose Adjust Color Curves (as shown here).

Step Two:
When the Adjust Color Curves dialog first appears, you’ve got two options for using it. First there’s the simple fix (I know, it’s not the official name, but it’s what we call it). This simple fix lets you simply select what you’d like to do with your photo from a list of choices on the bottom-left side of the dialog (you can compare the before and after views to see if you’re happy with the changes). Just click on a choice in the Select a Style list and it applies a color curve for you. Easy enough, right? (By the way, don’t click on Solarize unless you’ve had a few glasses of Merlot first.)

Note: You can only apply one curve at a time. If you want to apply more than one style adjustment, click OK, then reopen the Adjust Color Curves dialog and select another adjustment to add it.

Users of the full professional version of Adobe Photoshop have had the benefit of using Curves since version 1, and it’s the pros’ choice for color correction without a doubt. There’s only one problem—it’s a bit hard for most folks to master. That’s why you’ll fall in love with the Color Curves adjustment—it makes using Curves so easy, it will actually make pro users of Photoshop jealous. Adobe has done a really brilliant job of giving us the power of Curves without the hassles and steep learning curve. Life is good.
Step Three:
So, you might get lucky and find a choice that works great for you right off the bat. Your photo will look better, and life will be good. However, to reveal the real power of these curves, you’ll need to go to Adjust Sliders at the bottom right of the dialog. That’s where you’ll see four sliders and the curve itself. Now, as you drag the sliders, you’ll see how the curve is affected. For example, drag the Adjust Highlights slider to the right, and you’ll see the top-right curve point move upward. That's because the highlights are controlled by that upper-right point.

Step Four:
The center point represents the midtones in your photo. Try dragging the Midtone Brightness slider to the right, and look over at the curve. See how the center point moves upward? Now, drag the Midtone Contrast slider to the left, and watch how the contrast increases. Anytime you make the curve steeper, it adds contrast to your photo, but you don’t want it to get too steep, or your photo will lose quality. Lastly, drag the Adjust Shadows slider to the left. Notice how the shadow point on the curve (the far-left point) moves downward, darkening the shadow area. These sliders make it easy to adjust the tone and contrast in your photo without having to manually move points on the curve (like you do in the pro version of Photoshop).
Step Five:
Now, let’s click the Reset button and start over from scratch. Let’s fix the problem photo we have here, using nothing but Adjust Color Curves. First, let’s start with the preset styles and see if any of them look better than our current photo. To me, the Increase Contrast style looks better than the original photo, so go ahead and click on that. It makes a great starting point for our correction.

Step Six:
Okay, here’s the problem (at least as I see it). Although we increased the contrast, and I think the photo certainly looks better than it did, it seems a little dark, and it looks like it’s lacking highlights. So, drag the Adjust Highlights slider over to the right a little bit and see how that looks. Now, to me, that looks better (but hey, that’s just me. There is no official government agency that determines whether your photo has enough highlights or not, so the choice is really up to you—the photographer). In fact, since it’s up to you (or me, in this case), I think I might even drag it a little farther to the right, to really open up those highlights in the sky. In fact, I’ll keep dragging until the white areas of my photo start to look blown out (lacking detail).
Step Seven:
Now, if it were me (and it is, by the way), I’d then drag the Midtone Contrast slider to the right a bit to add more contrast in the midtones. I won’t do this for every photo, but for this photo, it seems to look better. That’s the great thing about these sliders—you can drag one to the left, and if your photo looks better, then great. If it doesn’t, drag it to the right and see how that looks. If it looks better when you drag it to the right, then great. If not, drag it back to the center and leave it alone. In this case, I dragged both ways, and I like the way the midtone contrast looked when I had the slider dragged to the right a bit, so that’s where I’m leaving it.

Step Eight:
My final two tweaks are to drag the Midtone Brightness slider to the left, then the right, to see which one looks better. I like the way it looks when I drag it to the left, so to the left it stays. I know this sounds like a really simplistic way to adjust your photos, but it’s deeper than you think. If you drag a slider in either direction, and your photo looks better, then how could that be wrong? Lastly, let’s drag the Adjust Shadows slider. Dragging just a little bit to the left seemed to make the shadow areas darker, while dragging it to the right made them look washed out. So, needless to say, I left it a little to the left. If you look at the curve itself, you’ll see the classic “S” shape (known as the “S” curve), which is pretty common in curve correction, as that shape adds contrast and helps to make colors rich and saturated. So, in short, don’t be afraid to slide those sliders.
Before

After
This page intentionally left blank
Index

[ ] (Bracket keys), 98, 256, 281
/ (Forward Slash key), 105
3D Pixelate transition, 41–42
100% view, 77, 88, 90

A
acne removal, 257–259
Add Noise filter, 321, 379
Adjust Color Curves dialog, 180–183
Adjust Color for Skin Tone dialog, 249
Adjust Color Intensity Amount slider, 347
Adjust Highlights slider, 181, 182
Adjust Intensity sliders, 133
Adjust Shadows slider, 181, 183
Adjust Sharpness control, 398–400
adjustment layers, 142–145
advantages of using, 142–143
color corrections with, 164–166, 237
creating new, 144
how they work, 145
retouching portraits with, 265, 270
selections and, 229, 234
Adjustments palette, 142–145
color channel controls, 177–178
Gradient Map options, 176
Hue/Saturation controls, 168, 172–173
Levels controls, 144
Photo Filter controls, 171
Threshold Level slider, 156, 161
Adobe RGB color space, 404
Album Details pane, 28, 52
albums, 28–30, 424
Albums palette, 28
Alignment tool, 225, 312
all-purpose sharpening, 386
Always Optimize for Printing option, 140
Amount slider
  Adjust Sharpness control, 399, 400
  Camera Raw Sharpening section, 88
  Correct Camera Distortion filter, 214
  Unsharp Mask dialog, 383, 387
Angle controls, 362, 396
antique photo effect, 346–351
Arrange button, 45
artifact removal, 301–302
Aspect Ratio pop-up menu, 110, 114
Auto Color Correction command, 151
Auto corrections, Camera Raw, 74, 99
Auto Smart Fix command, 147
Auto White Balance setting, 64–65
Auto-Analyzer, 20–21
Auto-Enhance checkbox, 241
automated processing, 129–130
automatic red-eye removal, 207–208
automatic special effects, 318

B
backgrounds
cropping to remove, 122
desaturation effect applied to, 322
removing subjects from, 243–245
backing up photos, 6–7
Backup Catalog option, 6
barrel distortion, 213
basic sharpening, 382–388
black-and-white conversions
  in Camera Raw, 99–101
  in Photoshop Elements, 175–179, 332–333
Blacks slider, 71–72, 76, 100
blemish removal, 255–256
blend modes, 143
blending multiple exposures, 219–225
Blue Skies effect, 172, 192
blur effects. See Gaussian Blur filter
blur removal options, 399
Blush slider, 249
Bracket keys ([ ]), 98, 256, 281
bright areas, 202–203
Bright Eyes effect, 265
Brightness slider, 73, 100
Brush Picker
  Brush tool and, 97, 238, 258
  Clone Stamp tool and, 260
Brush tool
color correction and, 171, 173–174
dodging/burning and, 196–198
double processing and, 97–98
emphasizing color using, 342–343
fill flash technique and, 205–206
layer masks and, 253–254
portrait retouching and, 258–259, 268, 281–283
selections and, 238
sharpening process and, 391
sizing/resizing, 98, 281
special effects and, 320, 366
See also Smart Brush tool
burned-in edge effect, 339–341, 349–350
burning and dodging method, 195–199

C
calibrating your monitor. See monitor calibration
Camera Calibration icon, 62
Camera Profiles, 62–63
Camera Raw, 59–101
  Auto corrections, 74, 99
  black-and-white conversions, 99–101
  Blacks slider, 71–72, 76, 100
  Brightness slider, 73, 100
  Camera Profiles, 62–63
  Clarity slider, 77–78, 99
  Contrast slider, 100
  Crop tool, 80–82
double processing in, 95–98
  Exposure slider, 68, 69–70, 100
  Fill Light slider, 75–76
  Full Screen view, 88
high-contrast look created in, 329–331
multiple photo editing in, 84–85
Noise Reduction section, 84
opening photos in, 60–61
Recovery slider, 70–71
Red Eye Removal tool, 93–94
Saturation slider, 79, 99
saving RAW files in, 86
Sharpening section, 87–91
Straighten tool, 83
Temperature slider, 65, 66
Tint slider, 65, 66
Vibrance slider, 79
White Balance settings, 64–67
See also RAW images
canvas area, 118–119
Canvas Options pop-up menu, 122
captions
entering for thumbnails, 10
finding photos using, 36
capture sharpening, 87
CDs, backing up photos to, 6–7
circular selections, 231–232
Clarity slider, 77–78, 99
Clean Edges dialog, 335
cropping photos, 104–120
canceling crops, 106
custom size options for, 112–114
gang-scanned images and, 120
lens distortion fixes and, 213
panorama stitching and, 335
portrait retouching and, 277
recomposing and, 136
rule of thirds for, 107–109
scene cleanup and, 314
shapes used for, 115–117
standard size options for, 110–111
steps in process of, 104–106
straightening and, 122
Cross, Dave, 160
Curves, Color, 180–184
custom crop  
  Camera Raw, 81  
  size settings, 112–114  
Custom Name option, 3  
Custom Shape Picker, 115

D

Daily Note option, 39  
dark circle removal, 260–261  
dark subject fixes, 204–206  
Darken blend mode, 338  
Darken Highlights slider, 203, 232  
Date View feature, 38–39  
Delete Options, 3  
deleting  
  keyword tags or albums, 32  
  photos from memory cards, 3  
  See also removing  
Density slider, 171  
depth-of-field effect, 245

desaturate effect, 319–323  
deselect command, 231  
Destination Settings screen, 7  
Detail slider, 89  
Difference blend mode, 160, 291  
digital cameras  
  camera profiles, 62–63  
  color cast issues, 152  
  lens distortion problems, 211–214  
Digital Negative (DNG) format, 82, 86  
digital noise  
  adding, 321, 322, 379  
  reducing, 92, 193–194  
digital photos  
  albums of, 28–30  
  backing up, 6–7  
  color correcting, 139–184  
  comparing, 43–46  
  cropping, 104–120  
  finding, 15, 25, 35–39  
  fixing problems in, 187–225  
  importing, 2–5, 423  
  info added to, 34  
  mapping, 49–53  
  metadata info for, 5, 33  
  opening multiple, 164  
  previewing, 11–12  
  recomposing, 131–137  
  renaming, 3  
  saving, 5  
  sharing, 54–56  
  sharpening, 381–400  
  sizing/resizing, 123–130  
  sorting, 13  
  stacking, 47–48  
  straightening, 121–122  
  tagging, 16–27  
digital workflow, 423–427  
Display button, 11, 38  
Display Calibrator Assistant, 408–410  
Distort filter, 272, 274  
distortion problems, 211–214  
  barrel distortion, 213  
  lens vignetting, 214  
  perspective distortion, 211–212  
distracting object removal, 303–310  
  Clone Stamp tool for, 304–305, 306  
  Content-Aware Fill for, 307–310  
  Healing Brush tool for, 303–306  
Divide Scanned Photos option, 120  
DNG file format, 82, 86  
DNG Profile Editor, 63  
Dodge and Burn tools, 195  
dodging and burning method, 195–199  
double processing, 95–98  
downsizing photos, 127–128  
drag-and-drop color correction, 164–166  
duotone effect, 376–377  
duplicating layers, 257, 262, 266, 342, 392  
DVDs, backing up photos to, 6–7

E

Edge Blending checkbox, 224  
edge sharpening, 395–397  
edge vignette effect, 326–328, 330–331, 373–374  
Edit Keyword Tag dialog, 31  
editing  
  adjustment layers, 145  
  multiple photos, 84–85  
  RAW images, 64–85  
  workflow for, 425–426  
effects. See special effects  
Elements Editor  
  comparing photos in, 45–46  
  cropping photos in, 104, 110, 112, 115  
  Guided Edit feature in, 216, 288, 318  
Elliptical Marquee tool, 231, 234  
Emboss filter, 396  
Enhance Details slider, 355  
 Eraser tool  
  eyeglass reflections and, 291  
  Group Shot merge and, 218  
  scene cleanup and, 313  
  special effects and, 328, 343, 374  
Eye icon, 145, 251, 284  
EXIF data, 33  
exporting keyword tags, 27  
 exposure adjustments, 68–73  
 Exposure slider, 68, 69–70, 100  
 external hard drive, 6  
 extraordinary sharpening, 389–391  
Eye icon, 145, 251, 284  
eye retouching  
  dark circle removal, 260–261  
  sparkle added to eyes, 266–268  
  whitening eyes, 264–265  
Eyedropper tool  
  color correction and, 153–155, 157–158, 163  
  fake duotone effect and, 376  
  neutral midtones and, 161  
  sample size settings, 141
eyeglass reflections, 288–293
Eye-One Display calibration, 411–413

F
Facebook sharing, 54–56
face-recognition feature, 24–25
facial retouching. See retouching portraits
faded antique effect, 346–351
fake duotone effect, 376–377
Feather Selection dialog
color correction and, 167
portrait retouching and, 264, 270
selection edge softening and, 235
vignette effect and, 340
files
automatically renaming, 130
processing multiple, 129–130
fill flash technique, 205–206
Fill Layer dialog, 160
Fill Light slider, 75–76
Film Grain filter, 378
film grain simulation effect, 378–379
filmstrip view, 12
filters. See specific filters by name
finding photos, 15, 25, 35–39
fixing image problems, 187–225
bright areas, 202–203
camera lens distortion, 211–214
dark subjects, 204–206
digital noise, 193–194
focusing light, 195–199
group shots, 215–218
Photomerge Exposure feature, 219–225
red-eye removal, 207–210
shadow areas, 200–201
Smart Brush adjustments, 188–192, 206
Flashlight effect, 337
Flatten Image command, 179, 192, 314, 393
Flatten Stack command, 48
flesh tone adjustments, 167–169
Flickr accounts, 53
focusing light, 195–199, 365–366
folders, watched, 9
Forward Slash key (/), 105
Fotolia.com website, xv
freckle or acne removal, 257–259
Free Transform
accessing hidden handles on, 126
portrait retouching and, 276–277
resizing images using, 126, 128
selection scaling and, 231, 239, 244
frown-into-smile technique, 274–275
Full Backup, 7
Full Screen view, 11, 40, 43, 88
full-screen previews, 11–12

G
gamma setting, 409
gang-scanned photos, 120
Gaussian Blur filter
depth-of-field effect and, 245
faded antique effect and, 351
portrait finishing technique and, 372
portrait retouching and, 257, 280
soft focus effect and, 344–345
Gaussian Blur removal, 399
Get Photos from Scanner dialog, 8
Getting Media dialog, 207
glasses, reflections in, 288–293
Gradient Editor, 361
Gradient Fill dialog, 359–360, 361–362
Gradient Map adjustment layer, 176
Gradient Picker, 359, 369
Gradient tool, 369
Grayscale mode, 175, 179
Grid option, 107–109
Group Shot feature, 215–218, 288–289
grungy high-contrast look, 329–331
Guided Edit feature, 216, 288, 318

H
halos, 89
Hand tool, 46
Hard Light blend mode, 396
hardware calibration, 411–413
HDR (High Dynamic Range) photography, 219
Healing Brush tool
disturbing object removal and, 303–306
portrait retouching and, 255–256, 261, 262
recomposed images and, 137
High Pass filter, 285
high-contrast look
Camera Raw technique for, 329–331
Photoshop Elements technique for, 324–328
Highlight Details slider, 221
Highlight Skintones option, 136
highlights
adjusting in Camera Raw, 68–71
clipping of, 68–71, 72
color correcting, 154, 157
darkening, 202–203
Histogram palette, 151
history, finding photos by, 37
Hollywood, Calvin, 324–328
Hue slider, 237
Hue/Saturation adjustments
color correction and, 168, 172–173
faded antique effect and, 348
portrait retouching and, 265, 270–271
selections and, 237

I
ICC profiles, 415, 416
icons
Crop, 82
keyword tag, 31
Stack, 47, 48
image files
automatically renaming, 130
processing multiple, 129–130
See also digital photos
Image Size dialog, 123–125
importing
digital photos, 2–5, 423
scanned photos, 8, 14
Incremental Backup, 7
information
adding to photos, 34
metadata, 5, 33
inkjet printer profiles, 414–417
Input Levels slider, 205, 234
interactive maps, 49–53
Inverse command, 234, 242, 325
Invert command, 325, 366
iStockphoto.com website, xv, 376

J
JPEG photos
cropping in Camera Raw, 80, 82
opening in Camera Raw, 61

K
kelbytraining.com website, xv
Keyword Tag Cloud, 19, 36
keyword tags, 16–27
adding to photos, 18–19, 22, 424
assigning multiple, 23
choosing icons for, 31
combining (merging), 26
creating, 16–17
deleting, 32
finding photos using, 35–36
mapping photos with, 49–51
people recognition and, 24–25
removing from photos, 22
selecting photos for, 22
sharing, 27
Smart Tags, 20–21
Keyword Tags palette, 16, 20, 23, 27, 35

L
Lasso tool
image fixes and, 202
portrait retouching and, 264, 269
selection techniques and, 240
sky replacement technique and, 356
layer blend modes, 143
layer masks, 250–254
adjustment layers and, 142
advantages of using, 253, 254
blending images with, 97–98
brushes and, 253–254
photo montages and, 368, 369, 370
retouching portraits with, 258, 267–268, 280–283
selections and, 251–253
sharpening photos with, 390–391
special effects and, 320–321
thumbnails for, 252
viewing, 282
Layer via Copy command, 257, 262, 266
layers
creating merged, 325
desaturating, 319
duplicating, 257, 262, 266
selecting, 239
See also adjustment layers
Layers palette, 97, 164, 206, 290
Lens Blur removal, 399
Lens distortion problems, 211–214
Lens vignetting, 214
Levels Auto button, 147
Levels controls, Adjustments palette, 144
black-and-white conversions and, 176, 177
color correction and, 144, 165
dark subject fixes and, 204
selection techniques and, 229, 234
taming light using, 365
Levels dialog
adjustment layers and, 143, 144
color correction and, 152–155, 157–158, 161, 163
special effects and, 349
light
focusing, 195–199, 365–366
taming, 365–366
Lighten blend mode, 258, 260
Lighten Shadows slider, 201, 203, 232, 326
Lighten Skin Tones preset, 206
Lighting Effects filter, 336–338
Lighting palette, 147
Lightness slider, 265, 271
Liquify dialog, 272, 274
Load Selection dialog, 233
Look Up Address dialog, 50
Luminosity blend mode, 366, 372, 393
luminosity sharpening, 392–394

Macintosh computers
calibration software on, 408–410
Organizer functions on, xiv
Magic Wand tool, 236–237, 356
Magnetic Lasso tool, 240
magnification settings, 382
Magnifying Glass. See Zoom tool
Map feature, 49–53
Mark for Protection tool, 133, 135
Mark for Removal tool, 133, 135
marquees. See selections
Mask for Protection tool, 135
Masking slider, 90
matching photo styles, 352–355
Maximize Mode, 118
maximum sharpening, 385
Media Browser button, 38
memory cards
deleting photos on, 3
importing photos from, 2–5
Merge Keyword Tags dialog, 26
merging
keyword tags, 26
layers, 325–326
multiple exposures, 219–225
metadata information, 5, 33, 423
Midpoint slider, 214
Midtone Brightness slider, 181, 183
Midtone Contrast slider, 181, 183, 203, 232
midtones
  adjusting in Camera Raw, 73
  color correcting, 154, 158
  finding neutral, 160–161
moderate sharpening, 385
monitor calibration, 405–413
  Adobe Gamma utility for, 405–407
  built-in Mac software for, 408–410
  hardware method of, 411–413
montages, 367–370
More Refined option, 400
Motion Blur removal, 399
Move tool
  collaging techniques and, 368
  rule-of-thirds cropping and, 108
Multiply blend mode, 327, 330, 349, 373

N
naming/renaming
  imported files, 3, 423
  multiple files automatically, 130
negative Clarity adjustment, 78
neutral density gradient effect, 359–362
neutral gray, 160–161
New Layer dialog, 196
New Smart Album dialog, 29
noise
  adding, 321, 322, 379
  reducing, 92, 193–194
Normal blend mode, 292
nose retouching, 272–273
notes
  adding to photos, 34
  finding photos using, 36
numbering photos, 130

O
object removal
  Clone Stamp tool for, 296–300, 304–305, 306
  Content-Aware Fill for, 307–310
  Healing Brush tool for, 303–306
  making selections for, 243–245
  See also unwanted object removal
Opacity settings
  edge sharpening and, 397
  fill flash technique and, 206
  lighting effects and, 338
  portrait retouching and, 258, 260, 263, 282, 287
  special effects and, 323, 345, 351, 358, 373, 379
  vignetting and, 340
Open dialog, 164
Open Settings Dialog button, 41
opening
  multiple photos, 164
  photos in Camera Raw, 60–61
Organizer, 1–56
  albums in, 28–30
  backup options in, 6–7
  comparing photos in, 43–44
  Date View feature, 38–39
  finding photos in, 15, 25, 35–39
  full-screen previews in, 11–12
  importing photos into, 2–5
  info added to photos in, 34
  Mac computers and, xiv
  Map mode in, 49–53
  scanning images into, 8, 14
  sharing photos from, 54–56
  sizing thumbnails in, 10
  slide show option, 40–42
  sorting photos by date in, 13
  stacking photos in, 47–48
  tagging photos in, 16–27
  viewing metadata info in, 33
  Watch Folders feature, 9
output sharpening, 87
oval selections, 231–232
overexposed areas, 202–203
Overlay blend mode, 196, 320, 323, 326, 360, 379

P
Page Setup dialog, 418
Palette Bin, 216, 288
palettes
  Adjustments, 142–145
  Albums, 28
  Color, 148
  Histogram, 151
  Keyword Tags, 16, 20, 23, 27, 35
  Layers, 97, 164, 206, 290
  Lighting, 147
  Properties, 33, 34
  Quick Edit, 40, 43
  Quick Organize, 40, 43
  Sharpness, 149
  Smart Fix, 146
  Undo History, 142
panning photos, 46
panoramas, 334–335
paper profiles, 414–417, 421
paper size options, 418
Paste Into Selection command, 230, 239, 357
Pencil tool, 217, 289, 313
people-recognition feature, 24–25
perspective distortion, 211–212
Photo Downloader, 2, 5, 207, 423
Photo Filter adjustments, 170–171, 245, 363
photo montages, 367–370
Photomerge Exposure feature, 219–225
  Automatic modes, 220–222
  Manual mode, 222–225
  Simple Blending option, 220
  Smart Blending option, 221–222
Photomerge Group Shot feature, 216–217, 288–289
Photomerge Panorama feature, 334–335
Photomerge Scene Cleaner, 312–314
Photomerge Style Match feature, 352–355
Photoshop.com website, 52
pin-registered photos, 96
plus-sign cursor, 297, 299
portraits  
color correcting, 162–163  
desaturation effect, 319–323  
finishing technique, 371–375  
sharpening, 371, 384  
See also retouching portraits  
Preferences dialog, 4  
Preserve Current Filename in XMP checkbox, 3  
Preserve Details slider, 194  
Preset Picker, 188  
previewing thumbnails, 11–12  
Print dialog, 418–419, 422  
printer profiles, 107–109  
printing process, 418–422  
Process Multiple Files dialog, 129–130  
profiles  
camera, 62–63  
monitor, 407, 410  
printer, 414–417, 421  
Project Bin, 45, 217, 289  
Properties palette, 33, 34  
pseudo-HDR technique, 219–225  
Pucker tool, 272–273  
Q  
Quick Edit palette, 40, 43  
Quick Fix mode, 146–150  
Quick Organize palette, 40, 43  
Quick Selection tool, 241–242  
color correction and, 167  
portrait retouching and, 264, 269  
selecting objects with, 233, 242, 243  
sky selected with, 356  
R  
Radius slider  
Adjust Sharpness control, 399  
Camera Raw sharpening section, 89  
High Pass filter dialog, 285  
Unsharp Mask dialog, 383, 387  
RAW images, 59–101  
auto correcting, 74, 99  
camera profiles, 62–63  
color vibrance in, 79  
converting to black-and-white, 99–101  
cropping, 80–82  
double processing, 95–98  
editing multiple, 84–85  
exposure adjustments, 68–73  
fill light used in, 75–76  
highlight adjustments, 68–71  
nose reduction, 92  
opening in Camera Raw, 60–61  
red-eye removal, 93–94  
saving in DNG format, 86  
shadow adjustments, 71–72  
sharpening, 87–91  
"snap" added to, 77–78  
white balance settings, 64–67  
See also Camera Raw  
Recompose tool, 131, 132–136  
Recovery slider, 70–71  
Rectangular Marquee tool  
selection techniques and, 228, 230, 251  
vignette effects and, 340, 349, 373  
rectangular selections, 228–229  
red-eye removal, 207–210  
automatic process of, 207–208  
Camera Raw feature for, 93–94  
instant method for, 209–210  
Reduce Color Noise slider, 193–194  
Reduce Noise filter, 193–194  
Refine Edge dialog, 327, 331, 350, 374  
reflections in eyeglasses, 288–293  
Remove Color command, 175, 242, 284, 377  
Remove Distortion slider, 213  
Remove Keyword Tag option, 22  
Remove pop-up menu, 399  
removing  
color from layers, 319  
distracting objects, 303–310  
eyeglass reflections, 288–293  
keyword tags, 22  
red-eye, 93–94, 207–210  
spots and artifacts, 301–302  
subjects from backgrounds, 243–245  
unwanted objects, 295–314  
See also deleting  
renaming. See naming/renaming  
Rendering Intent options, 422  
Resample Image option, 124, 125, 127  
Reset button, 147, 182  
resizing. See sizing/resizing  
resolution, 123–125, 128  
retouching portraits, 247–293  
blemish removal, 255–256  
dark circle removal, 260–261  
eyeglass reflection removal, 288–293  
freckle or acne removal, 257–259  
frown-into-smile technique, 274–275  
layer masks and, 258, 267–268, 280–283  
nose size reduction, 272–273  
skin softening, 279–287  
skin tone fix, 248–249  
smoothing/trimming technique, 276–278  
whitening eyes, 264–265  
whitening teeth, 269–271  
wrinkle removal, 262–263  
round selections, 231–232  
rule of thirds, 107–109  
rulers, 123  
S  
"S" curve, 183  
sampling, 296, 299  
Saturation slider  
B&W conversion and, 99  
color correction and, 168, 173  
Photomerge Exposure and, 222  
portrait retouching and, 265, 270  
"Snap" added to, 77–78  
white balance settings, 64–67  
See also Camera Raw
Index

RAW images and, 79
special effects and, 348
Save Options dialog, 86
Save Selection dialog, 233
saving
automated processing and, 129–130
digital photos, 5
keyword tags, 27
RAW files, 86
selections, 233
Scale slider, 212
Scale to Fit Media checkbox, 419
scaling selections, 231, 239, 244
scanned photos
date/time settings, 14
dividing gang-scanned images, 120
importing into Organizer, 8
scene cleanup, 311–314
Scenic Landscape style, 332
Screen blend mode, 348
searching for photos, 15, 25, 35–39
Select Transition dialog, 41
Selection Brush tool, 238
selections, 227–245
brushes for making, 238
changing color of, 237
color-based, 236–237
everything on a layer, 239
layer masks and, 251–253
object removal with, 243–245
Quick Selection tool, 241–242, 243
rectangular, 228–229
removing people from backgrounds, 243–245
round or circular, 231–232
saving, 233
scaling, 231, 239, 244
snapping to edges of, 240
softening edges of, 234–235
square, 230–231
tricky, 240
Set Date and Time dialog, 14
Set Date Range dialog, 36
shadows
adjusting in Camera Raw, 71–72
clipping warning, 72
color correcting, 153, 157
fill light for, 75–76
lightening, 200–201
removing, 308–309
Shadows slider, 147, 221
Shadows/Highlights dialog, 201, 203, 232, 326
shapes
cropping photos into, 115–117
selections based on, 228–232
sharing
Facebook, 54–56
keyword tags, 27
map photos, 52–53
sharpening techniques, 381–400
Adjust Sharpness control, 398–400
basic sharpening, 382–388
Camera Raw, 87–91
color correction and, 149
detail sharpening, 395–397
extraordinary sharpening, 389–391
luminosity sharpening, 390–391
portrait sharpening, 371, 384
sample settings, 91, 383–388
soft subjects and, 384
Web graphics and, 386
workflow order and, 426
Sharpness palette, 149
Show Strokes checkbox, 314
sharing your photos, xv, 426
similar photo search, 25
Simple Blending option, 220
simulated film grain effect, 378–379
sizing/resizing
automated, 130
brush tools, 98, 256, 281
cropped photos, 110–114
digital camera photos, 123–130
downsizing process and, 127–128
dragging between documents and, 128
Free Transform handles for, 126, 128
parts of images, 131–137
skies
color correcting, 172–174
Smart Brush adjustment, 172, 188–192
technique for replacing, 356–358
skin softening, 78, 279–287
skin tone fix, 248–249
skylight filter effect, 363–364
slide shows, 40–42
presentation options, 41
transitions for, 41–42
video on creating, 40
Slideshow Settings dialog, 52
slimming/trimming technique, 276–278
Smart Albums, 29–30
Smart Blending option, 221–222
Smart Brush tool, 188–192
adjusting settings in, 191
presets in, 188, 191–192, 206, 265, 271
steps for using, 188–190
Smart Fix option, 146–147
Smart Tags, 20–21
smiles, changing frowns into, 274–275
snap-to-edges feature, 240
soft focus effect, 344–345
Soft Light blend mode, 198, 286, 320, 364, 378
soft spotlight effect, 336–338
soft subject sharpening, 384
softening techniques
dragging between documents and, 128
effects of selections, 234–235
skin softening, 78, 279–287
vignettes, 331, 340, 374
sort photos on, 13
sparking eyes, 266–268
special effects, 317–379
automatic or built-in, 318
The Photoshop Elements 9 Book for Digital Photographers

435
special effects (continued)
black-and-white conversions, 332–333
burned-in edge effect, 339–341, 349–350
Camera Raw used for, 329–331
desaturated portrait effect, 319–323
emphasizing objects with color, 342–343
faded antique effect, 346–351
fake duotone effect, 376–377
high-contrast look, 324–331
matching photo styles, 352–355
neutral density gradient effect, 359–362
panoramas, 334–335
photo montages, 367–370
portrait finishing technique, 371–375
simulated film grain effect, 378–379
sky replacement technique, 356–358
skylight filter effect, 363–364
soft focus effect, 344–345
soft spotlight effect, 336–338
taming your light, 365–366
vignetting, 339–341
workflow order and, 425
specular highlights, 72
Spot Healing Brush tool, 207–208, 301–302, 310
spot removal, 301–302
square selections, 230–231
sRGB color space, 404
Stack icon, 47, 48
stacking photos, 47–48
standard photo sizes, 110–111
stock photo websites, 376
Straighten tool
Camera Raw, 83
Photoshop Elements, 121–122
straightening photos, 121–122
cropping and, 122
RAW images, 83
studio photo correction, 162–163
Style Bin, 352–353
Style Clarity slider, 354
Style Intensity slider, 354
Style Match feature, 352–355
Surface Blur dialog, 325
swatch card, 67, 162–163
T
tags. See keyword tags
taming light, 365–366
Tan slider, 249
target cursor, 296
teeth whitening technique, 269–271
Temperature slider, 65, 66
text search field, 37
Threshold adjustment layer, 155–156, 161
Threshold slider, Unsharp Mask dialog, 383, 388
thumbnails
layer mask, 252
previewing, 11–12
Quick Fix mode, 148
sizing, 10
TIFF photos
cropping in Camera Raw, 80, 82
opening in Camera Raw, 61
tiling photos, 45
Timeline, 15, 35
Tint slider, 65, 66
Toggle Film Strip button, 12
Tolerance setting, 237
tonal adjustments, 151, 164
tools. See specific tools by name
tourists, removing from photos, 311–314
Transfer Tones checkbox, 353
transitions for slide shows, 41–42
Transparency slider, 223
tripods, 225, 311
U
UnCheck All button, 5
underexposed subjects, 204–206
Undo command, 273, 309, 369
Undo History palette, 142
Unsharp Mask filter
Adjust Sharpness control vs., 398
basic sharpening and, 382–388
digital noise and, 322
extraordinary sharpening and, 389–390
luminosity sharpening and, 393
portrait finishing technique and, 371
portrait retouching and, 266–267
resized photos and, 127, 128
sample settings, 383–388
See also sharpening techniques
uploading Facebook photos, 56
V
Version Sets, 208
Vertical Perspective slider, 211
Very Pearly Whites effect, 271
Vibrance slider, 79
video on showing your work, xv, 426
vignette effects
burned-in edge effect, 339–341, 349–350
digital noise and, 322
effective sharpening and, 389–390
luminosity sharpening and, 393
portrait finishing technique and, 371
portrait retouching and, 266–267
resized photos and, 127, 128
sample settings, 383–388
See also sharpening techniques
web sharpening, 386
White Balance settings, 64–67, 100
White Balance tool, 66, 67
white point setting, 410
whitening techniques
for eyes, 264–265
for teeth, 269–271
workflow order, 423–427
wrinkle removal, 262–263
Z
Zoom tool, 46, 77, 88, 209, 313